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1. Preliminary Steps before Transcribing

Before you are able to start transcribing a Greek manuscript, you will need to ensure that:
*  Your operating system will support Unicode.
*  You have an appropriate Programme loaded.
*  You have downloaded Gentium, the best Greek polytonic Unicode font for transcribing.
*  You can switch between a American/British keyboard and a Greek polytonic one.
*  You have access to the Character Palette (Mac) or Character Map (Windows).
*  You have downloaded an appropriate base text.
*  You have downloaded an appropriate Items for Copy and Paste document.

Each of these points, including instructions on use where necessary, will be addressed in this first
section.

1.1 Operating Systems

In this section, there are instructions for preparing to transcribe using Macintosh and Microsoft
Windows operating systems. All transcriptions must be Unicode compatible, which means that your
operating system must provide Unicode support. Macintosh has included Unicode support since
version 8.5. Microsoft began supporting Unicode with Windows NT 3.1 and Windows 95.

1.2 Programmes

Transcriptions can be made in any of the following programmes: jEdit, BBEdit or Microsoft Word.'
Separate instructions for using Microsoft Word (on a Mac and a PC) for transcribing are currently
available; IGNTP transcribers should contact either Bruce Morrill at bruce@math.ksu.edu or Rachel
Kevern at r.kevern@bham.ac.uk for a copy of these instructions.

1.3 Font

The process of transcribing requires that you use a Greek polytonic Unicode font. One advantage of
using a Unicode font for transcribing is that you can switch between English and Greek without
changing fonts. Another advantage is that you can choose from a range of Greek polytonic fonts,
some of which are more complete, and more attractive, than others.

The best font for our purposes is Gentium (or Gentium Plus), which has both Windows and
Macintosh versions. It is recommended that you use this. It is attractive and easy to read in English
and Greek and contains all the various symbols needed for a transcription.”

! BBEdit and Microsoft Word must be Unicode compatible versions.
? Gentium does not include Greek numerals.



Gentium is freely available at
http://scripts.sil.org/cms/scripts/page.php?item id=Gentium_download

Scroll down the page and beneath ‘Download’ are a series of links for downloading the font. Click
on the relevant one for your operating system, and follow on-screen instructions. Note that once the
package has been downloaded, you will need a decompression utility such as WinZip (Windows) or
Stuftit Expander (Macintosh) to expand the archive. Mac OS X will automatically expand the
archive. Windows XP has a built-in archive expander. Within the archive are the font files and a
Read Me. The Read Me includes basic instructions for installing the fonts.

1.4 Switching Keyboard Layouts

In order to be able to input Greek characters in your transcription you will need to add a Greek
keyboard layout.

1.4.1 Macintosh OS X

1. Go to System Preferences>International>Input Menu. Scroll down and tick the box next to

‘Greek Polytonic’:
N.YoXe International
[ <[> || showal | Q

! Language Formats InputMenu]

Select the keyboard layouts, input methods, and palettes for the input menu.

On | Name Input type 4| Script
1 = Greek Keyboard Unicode
™ %Greek Polytonic Keyboard Unicode
O Guijarati Keyboard Unicode

At the bottom of the ‘International’ screen, tick ‘Show input menu in menu bar’. A little
American or British flag will appear in the right-hand corner of the menu bar at the top of
your screen, depending on your default input language.

To write in Greek you can either:

a) Click on the flag, then click on ‘Greek Polytonic’ and start typing. To revert to writing
English open again and click on ‘U.S.” or ‘British’.

Or:

b) Use a keyboard shortcut to switch between the American/British keyboard and the Greek
Polytonic one. This option is the quickest and easiest and is recommended. The keyboard
shortcut is Command + Space. If the keyboard layouts don’t switch when you key this
shortcut, you need to change the default settings. Go to System Preferences>Keyboard and
Mouse. Scroll down the list of shortcuts and check ‘Input Menu’ and uncheck ‘Spotlight’
(which is the default keyboard shortcut on some systems):



e 0 Keyboard & Mouse
| <[> |[ showall | Q

! Keyboard Bluetooth ' Keyboard Shortcuts )

To change a shortcut, double-click the shortcut and hold down the new keys.

On | Description Shortcut

™  ¥input Menu

4 Select the previous input source 28 Space
K4 Select the next input source in the Input menu & Space
4

™  vDisplay

This will allow you to switch between the American/British keyboard and the Greek Polytonic one
by typing Command + Space.’

It can also be helpful to be able to view the keyboard layouts in order to find which keys relate to
which Greek characters.* To do this, go to System Preferences>International>Input Menu and
check ‘Keyboard Viewer.” To view the keyboard layout, go to the flag on the menu bar and click
‘Show Keyboard Viewer’. If you are in Greek Polytonic mode, the keyboard that appears will show
you the position of the various Greek characters on your keyboard. If you press Shift, Shift and Alt,
or Alt, while viewing the keyboard layout, the positions of these characters will also be displayed.

1.4.2 Windows Vista

1. Go to Start>Control Panel>Clock, Language, and Region>Change keyboards or other input
methods.

2. In the ‘Regional and Language Options’ window, open the ‘Keyboards and Languages’ tab
and click ‘Change keyboards’.

3. In the ‘Text Services and Input Languages window, open the ‘General’ tab and click on
‘Add’ under ‘Installed Services’.

4. Scroll down the list of languages and click the little box next to ‘Greek’ and a ‘Keyboard’
checkbox opens. Click the little box next to ‘Keyboard’ and check ‘Greek Polytonic’. Click
‘OK”.

* If you have more than two keyboard layouts in use, use Command + Space to select previous input source and
Command + Option (alt) + Space to select the next input source.
* General Keystroke tables for Gentium Greek Polytonic can also be found in the Appendix.



we Add Input Language &J“

Select the language to add using the checkboxes below. [ oK |
Galician (Galician) - ——
Georgian (Georgia) KL&'I
German (Austria) l Dreview l

German (Germany)
German (Liechtenstein)
German (Luxembourg)
German (Switzerland)
Greek (Greece)
-] Keyboard
Greek
Greek (220)
Greek (220) Latin
Greek (319)
Greek (319) Latin

o o I e e

m

Show More... v
< " )

5. Back on the ‘Text Services and Input Languages’ window, open the ‘Language Bar’ tab.
You can select where you wish the Language Bar to appear. The default position is ‘Docked
in the taskbar’.

To write in Greek you can either:

a) Click on the EN icon in the taskbar, then select ‘EL Greek’ and start typing. To revert to
writing English click on the EL icon and select EN.

Or:

b) Use a keyboard shortcut to switch between English (US or UK) keyboard and the Greek
Polytonic one. This option is the quickest and easiest and is recommended. The default
keyboard shortcut is Left Alt + Shift. If Left Alt + Shift does not work on your computer, go
to Start>Control Panel>Clock, Language, and Region>Change keyboards or other input
methods. In the ‘Regional and Language Options’ window, open the ‘Keyboards and
Languages’ tab and click ‘Change keyboards’. Select the ‘Advanced Key Settings’ tab.
Under ‘Hot keys for input languages’ you will see the key sequence required to switch
between input languages.



r

we Text Services and Input Languages

General | Language Bar | Advanced Key Settings

To tum off Caps Lock

@) Press the CAPS LOCK key Press the SHIET key

Hot keys for input languages

To Greek (Greece) - Greek Polytonic
To English (United Kingdom) - United Kingdom

Action Key sequence
Between input languages Left Alt+Shift

(None)
(None)

[ Change Key Sequence...

]

oK || Ccancel

1.4.3 Windows XP

(98]

In the Windows XP standard Start menu, go to Start>Control Panel. In the Windows XP
classic Start menu, go to Start>Settings>Control Panel.

Double-click ‘Regional and Language Options’. Click the ‘Languages’ tab, and under ‘Text
Services and Input Languages’ click ‘Details...’

Under ‘Installed Services’ click ‘Add...” to go to ‘Add Input Language.’

From the ‘Input language’ drop-down menu, select ‘Greek’. From the ‘Keyboard
layout/IME’ drop-down menu select ‘Greek Polytonic’ and click OK.

Add Input language

Input language:

’ Greek

[v]

Keyboard layout/IME:

’ Greek Polytonic

[v]

[ ok

I[ Cancel ]

You will be taken back to the ‘Text Services and Input Languages,’ click ‘Apply’.

Under ‘Preferences’ click ‘Language Bar...” Check that ‘Show the Language bar on the
desktop’ and ‘Show additional Language bar icons in the taskbar’ have ticks against them
and click OK. If they don’t already have ticks against them, tick them and click ‘OK”.



(Language Bar Settings

[V]:Show the Language bar on the desktop

Show additional Language bar icons in the taskbar

[ oK

][ Cancel ]

6. Back on the ‘Text Services and Input Languages’ box, click ‘Apply’ if necessary. (If
‘Apply’ is very pale there is no need to do this). A little keyboard icon (EN for English) will
show on the taskbar at the bottom of the screen.

To write in Greek you can either:

Or:

c) Click on the EN icon, then select ‘EL Greek’ and start typing. To revert to writing English

d)

click on the EL icon and select EN.

Use a keyboard shortcut to switch between the English keyboard and the Greek Polytonic
one. This option is the quickest and easiest and is recommended. The default keyboard
shortcut is Left Alt + Shift. If Left Alt + Shift does not work on your computer, go to
Start>Control Panel (or Start>Settings>Control Panel), double click on the ‘Regional and
Language Options’, click on the ‘Languages’ tab, ‘Details,” and under ‘Preferences’ select
‘Key Settings.” Under ‘Hot keys for input languages’ you will see the key sequence required

to switch between input languages.

(Advanced Key Settings

Ax]

To turn off Caps Lock
() Press the CAPS LOCK key

Hot keys for input languages
Action

() Press the SHIET key

Key sequence

‘Switch between input languages

Left Alt+Shift

Switch to English (United Kingdom) - United Kingdom
Switch to Greek - Greek Polytonic

[None)
[None)

[ Change Key Sequence... ]

| |

Cancel

]




1.4.4 Windows 2000°

Go to Start>Settings>Control Panel.

. Double-click ‘Regional Settings’.

3. Click the General tab, click to select the check box next to the appropriate language group
you wish to install, and then click Apply. The system will either prompt for a Windows
2000 CD-ROM or access the system files across the network. Once the language is installed,
Windows 2000 will prompt you to restart the computer.

Again go to Start>Settings>Control Panel.

Double-click ‘Regional Settings’.

Click the Input Locales tab.

In the Input Locales box, click the Greek language, and then click Properties.

In the Keyboard Layout box, click the Greek keyboard layout, click OK, and then click OK.

N —

XNk

1.5 Character Palette/Map

You may want to manually add certain characters to your transcription that are not available on a
regular keyboard, such as overlines and underdots.® In order to do that, you will need to be able to
copy and paste them from a palette of characters.

1.5.1 Macintosh OS X

1. Go to System Preferences>International>Input Menu. Tick the box next to ‘Character
Palette’ and close box:

®eo0r International
[ «[» | [ Showall | Q

' Language Formats InputMenu]

Select the keyboard layouts, input methods, and palettes for the input menu.

On Name Input type | Script
4 [:] Character Palette Palette Unicode O
O Japanese Kana Palette Palette Japanese
4 [&2] Keyboard Viewer Palette Unicode

2. To view the character palette, click on the American/British flag on the menu bar and click
‘Show Character Palette’.

3. At the top of the ‘Characters’ window, select ‘Code Tables’ from the drop down menu of
‘View’ and select ‘Unicode:’

> This information about installing the Greek keyboard layouts using Windows 2000 is from
http://www.biblicalgreek.org/links/fonts/keyboard.html. T have not checked the accuracy of this information.

% Tags, entities and other characters that might be needed for the transcription are also available for copy and paste, see
1.7 Items for Copy and Paste Document.




000 Characters

View :': Code Tables ?]
" Unicode Other Encodings Favorites |

Unicode Title Category
00000250  IPA Extensions Latin

000002BC  Spacing Modifier Letters Modifier Letters
00000300 Combining Diacritical Marks Combining Marks
00000370  Greek and Coptic Greek

00000400  Cyrillic Cyrillic
00000500 = Cyrillic Supplement Cyrillic

4. Make sure that ‘» Character Info’ and ‘P Font Variation’ are opened by clicking on the
arrows:

W Character Info
, Related

p Ppe,p

Name : GREEX SMALL LETTER RHO

Unicode : 03C1 UTF8: CF 8
W Font Variation
Collections : [ Containing selected character ﬂ
FGUNYSE0 FPUNYUNGRD  #PIGI Appie Appie

Regular Regular Regular  LiGot...dlum LiSung Light

p D O p P

| Aral Batang BlauKal Century Courier
| Unico..gular Regular Regular Regular New Bold

You are now ready to add Unicode characters. If you want to find a Unicode character that is
required in your transcription:

1. Type the number, for example 0305 — the combining overline,” in the little window at the
bottom and click on the magnifying glass. Either the character will appear, or a choice of
characters may appear, as:

w
Character code :
. 0, Quwe .
% |
- Unicode
(Q 0305 ) ( Insert )

2. Double click on the Unicode one (in this instance, the combining overline) and it will appear
in the ‘Character Info’ box:

W Character Info
. Related

Name : COMBINING OVERLINE
Unicode : 0305

" You will be given the necessary Unicode characters references later in this document.
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3. Place your cursor after the letter in your transcription which you wish to modify and click
once on the modifying character in the box on the left under ‘Character Info’. It should
appear in your transcription. If it doesn’t, it can be dragged and dropped.

1.5.2 Windows Vista and XP
The Character Map may already be visible in your Start menu. If it is not:

1. Go to Start>All Programmes>Accessories>System Tools>Character Map.
Select ‘Gentium’ in the ‘Font’ drop-down menu.

3. Check ‘Advanced view’ and then select ‘Unicode’ from the ‘Character set” drop-down menu
and ‘All’ from the ‘Group by’ drop-down menu.

4. To find a Unicode character that you require for your transcription, type in the number, for
example 0305 — the Combining Overline — in the ‘Go to Unicode’ box. The correct character
will be highlighted in the table of characters:

b

2 Character Map E]

Font: | 0 Gentium v[
F— v . " 3 . » b 1 " " -4 ~ < b c i 4 N
A VR R N D 0 S e Vo P O A O O e e
I R ‘EI'H|‘T|O|Y|Q|T|A|B|T|A|[E|[Z|H|®
I|K[AM|N|ZE|O|O[P|Z|T|Y|OX|¥|Q|T|Y|&]é
Al L[ |a|Bly|S]e|l|n|O|L|{x|A|lp|v|E|o|n|p
glo|t|u|@|x|v|o|i|t]|d]|d|d]|8|8|Y|Y|Y|d|S
INJIA|B|T|EM[H|O|ITI|P|C|T|O|X elo|p|c
x|s|i|j|1|E|=|a|e|3|3|6|e|A|a|B|b|Bb|B|L

Characters to copy : | | Select l

Advanced view

Character set : Unicode _Yl Go to Unicode : 0305

Group by : All Vl

Search for :

U+0305: Combining Overline

5. Either double-click on the highlighted character or click ‘Select’ and it will display in the
‘Characters to copy’ box (though it may be difficult to actually see if it is something like a
single combining overline). You may select a series of characters in this manner, such as a
theta, a nu and a combining overline to create ‘OV’.

6. Click on ‘Copy’, go to your transcription and place your cursor after the letter in the
transcription that you wish to modify and select ‘Paste’ from the Word Edit menu or Ctrl +

V. Alternatively, you may copy characters by dragging them from the Character Map and
dropping them into your open document.

11



1.6 Base Texts

To begin a transcription, you will need a base text.

A base text is an existing electronic text against which you will compare a manuscript text. In order
to read a base text correctly, you will need to have already downloaded the Gentium font. Each
individual manuscript differs from the base text. You will change the base text so that it matches the
manuscript you are reading exactly and rename the base text with the name of the manuscript you
are transcribing. The base text is arranged according to chapters and verses, with the book number
also recorded at the beginning.

At the top of the base text is a status note form which is to be filled in, initially by the transcriber,
providing some basic information about the transcription itself and major features of the text to be
transcribed. It is later used to add information relevant to the processing of the transcription.

IGNTP transcribers should contact either Bruce Morrill at bruce@math.ksu.edu or Rachel Kevern
at r.kevern@bham.ac.uk who will email you the correct Unicode base text.

Currently, the Unicode base text contains the TR (Textus Receptus)® and is without accents,
breathing marks or punctuation.” It uses the nomina sacra in their most common forms and so the
base text is called TRns. Note that final sigma (¢) is used in the base text and should also be used in
your transcription. On the Greek Polytonic keyboard, ¢ is located at the ‘w’ key.

1.7 Items for Copy and Paste Document

In the process of creating a transcription, you will need to add tags and entities that provide the user
with certain information (tags and entities will be discussed further in the next three sections) about
the text you are transcribing. These can be simply typed. The disadvantage of typing them is that it
is easy to introduce error. It is recommended that you copy and paste material from a document
called ltems for Copy and Paste, which is available from your supervisor. All of the tags, entities,
punctuation and other symbols you are ever likely to need can be copied from this document and
pasted into your transcription.

¥ Also known as the Received Text, see ‘Received Text’ in Glossary.
? There are occasional exceptions: they are recorded when the accenting/breathing alters the meaning of the text, see
5.8.2. Accents and Breathing Marks.
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2. Reference: Symbols and Example Page

Frequently Used Symbols

Block Markers

<B 00>
<K 00>
<V 00>

Tags
There should always be a space between the letter and the following number in the following tags:

|[F 000r| (Folio number; recto)
|[F 000v| (Folio number; verso)
[P 000| (Page number)

|C 0| (Column number)

There should be no spaces within or between the following tags, or between the tag and the word or
words that are being tagged:

IL| (Line)

[€I[\] (Alt+o Lacuna)

[N (1legible)

lapp][*I[\V*I[CI\C][\app]  (First hand and corrector)
[app][*]&om;[\*][C][\C][\app]  (First hand omission and correction)
[app][*I\V*¥IIC*I[\C*][\app]  (First hand and first hand correction)
[app][*][\*][CT1][\C1][\app]  (First hand and corrector 1)
[app][*I[\*][C2][\C2][\app]  (First hand and corrector 2)
[app][*I[\*IIC3][\C3][\app]  (First hand and corrector 3)
lapp][*][\*IIKI[\K]\app]  (Text and commentary reading)
lapp][*I[\*I[AINA]\app]  (Text and alternative reading)

Other Entities and Symbols

&om; (Omission) &lac; (Lacuna)
&ews; (emcrecorded in commentary manuscripts indicating left out text)

{fom} (Omission) {comm} (Commentary text)

(Combining overline: Unicode 0305)
(Combining dot below: Unicode 0323)

' The “illegible’ tag is not used by INTF transcribers.

13



Example Page

|F 1r|"!

|c1| or

{IF 1r(|C 1[}

[L|<B 23> <K 4> <V 11> &lac;'?

IL|o [app][*16c[\*][Cluc[\C][\app] tampicev n[eJuag kot nueig\<]
ILlog1Aouev aAAn[2]Aovg ayamav(\2]

IL|< V 12> {fom} < V 13> ovde1g momote t[*JeBearton[\?]

IL|tov e1v eav ayan[Jwuev aAAn[\2]=

IL[Aovg o [app][*18a[\*][C*InAag\C*][\app] & npv [Juever ki n a=
|ILlyamn[\e] avtov t[Jeteer=

IL|wuevn[\e] &lac; {4.13}

|F 1v]|

|L|<V 14> &lac;

|L|ome[2]5-7[\%]o [¢]uiov cwtn=

IL|pa Tov koou[\Jov <V 15> [2]o¢ eav opolo=

ILlynon ot [\lg e[Jo[\Jrwv o [*Ju[\°]§ Tov

|L|[2]6T o 6¢C ev[\*] avtw uever kat

IL|[*]avtog ev auf\® ]tco got1 <V 16> ka1 [app][*Inue[\*][CInuec[\C][\app]
IL|[2leyvoxaue[\2]v ko memiotevKa=

IL|[Juev tnv[\°] ayarnv nv ext o xpg

IL|[2]ev nuwv o 6[\¢]c ayamn eotiv ka[]i[\?]

IL|o uevwv e[\2]v T ayamn ev

IL|[2]0G& pever ko o O[\2]g ev avtw w[*]evet

ILtavrac eimev t[\Joic wadnralill]ic avtou|\ill]

IL|<V 17> [Jo1date[\] ot [ill]3-4[\ill]" yevo=

|L|[2Juevagl\¢] &lac; {4.18 end}

"' Those not including page layout information in their transcriptions should ignore the folio and column number tags
(|F 1r| and |C 1]) and line break tags (|L|).

? &lac; here means that the entire line of text is missing because the parchment itself is missing.
' The base text here reads peta Svo nuepag mavrag which doesn’t fit the space available here, so an approximate
number of illegible letters has been added between the [ill]...[\ill] tags.
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3. Preparing a Transcription

Having added the Greek keyboard and character palette/map and downloaded Gentium, a base text
and the Iltems for Copy and Paste document, you are ready to begin a transcription. First, it is useful
to understand several important terms frequently used in text editing:

3.1 Important Terms

Tag

Block Marker

Line Break

Entity

A tag is a control character which provides the programme with important
information for the editing of the text. Tags consist of an opening element
and a closing element that surround the text, for example, [*]moovg[\*]. The
closing tag corresponds to the opening tag, but with the addition of ‘\’ a
Reverse Solidus. Tags always begin and end with square brackets [ ].

Block markers flag the beginning of books, chapters and verses. They consist
of ‘<’ a Less-Than Sign, a capital letter (B = Book, K = Chapter, V = Verse),
a space, a number and a >’ a Greater-Than Sign. For example, <B 04>
means Book 4 (John). It is important that these block markers remain in
exactly the same form throughout the transcription.

Line breaks flag the beginning of a new line in the manuscript being
transcribed. They are tagged as |L|.

An entity 1s a marker that shows you something about the text, for example,
that it has been omitted by the scribe, or that it is missing due to loss of
physical material. An entity begins with an ampersand, ‘&’ and ends with a

semicolon ;’ (e.g. &om; for omission) thus distinguishing the characters
within the & and ; from the actual text.

3.2 Naming the Transcription

The first thing to do in any transcription is to name the transcription file.

The name consists of a document number (for example 04 for John, John being the fourth book of
the New Testament), a six digit number depending on the type of manuscript (see below), and the
initials of the transcriber, all separated by low lines (Shift + -). The six-digit number consists of

three parts:

Type of Manuscript Manuscript Number Supplement
Example: 1 0074 0
Possible options: 1 = Papyrus Always four digits. Fill 0 = text written by first
2 = Majuscule missing digits with zero. hand(s)
3 = Minuscule 1 = supplement 1
4 = Lectionary 2 = supplement 2, etc.

'* See 6. Supplements and ‘Supplement’ in Glossary.
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The manuscript number is the Gregory-Aland number that has been assigned to all New Testament
manuscripts. So, as an example, if I transcribe John from a minuscule with the Gregory-Aland
number 156, I give it the file name 04 301560 rk.

To name your transcription, open your base text and click on ‘Save As’ in the ‘File’ menu. Type the
name of the file and where you want it saved.

3.3 Status Note

At the beginning of the base text that you have downloaded is a Status Note.

In it, record the Gregory-Aland number of the manuscript you are about to transcribe and the name
of the book and the number of the first folio of that book. Place your initials next to ‘Transcribed
by:” and the date the transcription is begun, and when it is finished. So, the beginning of the Status
Note of 04 310140 rk would look like:

{Status:

G-A Number: 1014

Name of book transcribed: John
First folio transcribed: 22 1r
Base text used: TRns

Transcribed by: RK
Transcription begun: 02.09.08
Transcription finished: 11.11.08

In the Status Note there are also four questions that require yes or no answers that should be
completed. The first three relate to the manuscript text as a whole, the fourth relates to specific
verses:

Does this manuscript contain (delete as appropriate):
Lectionary annotations - Yes No
Initials and other enlarged letters - Yes No
Diples (> or >> in the margin next to certain text, indicating that the text is a quotation from
the Old Testament) — Yes No
Are there any special symbols in the margin next to any of the following verses:
54 Yes No
7.53-8.11 Yes No

There is also a space for other remarks that you might wish to make about the text as a whole, for
example, ‘Very heavily abbreviated’ or ‘lota adscript used’:

Other remarks:
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4. Recording Folios, Pages, Columns and Lines

Two, independent transcriptions are made of every manuscript. One transcription must include page
layout information; it is not necessary for both transcriptions to contain this information. If you
have been asked to produce a transcription with page layout information included, you will need to
tag folio or page numbers, column numbers and every line. Instructions for doing this follow. If you
have not been asked to record page layout information in your transcription, skip the next section
and go to 5. Alterations to the Base Text in the Transcription.

All of the tags in this section can be typed, or copied and pasted from the Items to Copy and Paste
document. None of them require the Greek Polytonic keyboard.

4.1 Folios, Pages, Columns and Lines

Folio At the beginning of every new folio,"” the folio number must be recorded and
whether it is recto (right-hand side of an opening) or verso (left-hand side of an
opening). They are marked as follows: |[F 000r| (|F, space, Arabic numeral, 1|) for a
recto folio and |F 000v]| (|F, space, Arabic numeral, v|) for a verso folio, replacing the
‘000’ with the folio number as it is recorded on the manuscript (usually recorded in
the top right-hand corner on the recto side). Note: If a folio number has one or two
numerals, it is recorded as, for example, |[F 3r| or |[F 45v|, i.e., there should be no
numeral 0 before the number.

Page If the folio number is missing, or if every page of a manuscript is numbered, the
modern page number, tagged as [P 000| (|P, space, Arabic numeral|), should be used.
As with numbering folios, if a page has one or two numerals, it is recorded as, for
example, [P 5| or |P 17|.

Column Columns tags are added to the transcription if there are two or more columns to a
page. They are tagged as follows: |C 0|, with a number replacing the ‘0’ (|C, space,
Arabic numeral|). The folio number precedes only the first column tag; it is not
repeated before subsequent columns.

Line All new lines are preceded by the following tag: [L|. It is visually helpful to add a
carriage return at the end of the preceding line and before the line break tag.

Folio and column numbers are placed before the first line of text, before the first block markers.
There is no line break tag preceding a folio or column number, but one must precede the first block
marker and beginning of the text:

' See “Folio’ in Glossary.
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Example: Folio and Column Number at the Beginning of Transcription

|F 200r|
|C 1
|L|<B 02> <K 1> <V 1> apxn tov gvavyeAALOU ...

The block markers should be separated by spaces but there should never be a space between a line
break tag and a block marker.

Throughout the rest of the text, the folio and column numbers are placed on separate lines, again,
without line break tags:

Example: Folio and Column Number in the Middle of Transcription

IL|o famtiopa ...

|F 202r|

IC 1

IL|epnuw xat ...
ILlowv pantiopa ...
|L|tavorag ...

Ic 2|
[Llvtodnuatwy ...

New lines in the manuscript are indicated in the transcription with the tag |L| at the beginning of

every new line. There should never be a space between the line break tag and the word that comes
after it.

Each line that ends in a complete word should end with a space before hitting ‘carriage return’ to

start a new line. In practice, this means placing the cursor after a space between words, immediately
to the left of the word that is to start the new line.

4.2 Text Beginning Part Way Down a Page

Very occasionally, a text to be transcribed does not begin at the beginning of a page, rather, the
same page contains the end of one text and the beginning of the text to be transcribed. This is most
common in the Catholic Epistles but very rare in the larger books such as the Gospels. In such
instances, the rule for tagging the first folio and column is modified:

* If the text has only one column, the folio number is placed in braces/curly brackets: { }. See
example 2 below.
* If the text has multiple columns, either,
» The folio tag is recorded after the column tag, if the text begins on the first line of a
column (see example 3) or,
» If the text begins part way down a column, both the folio number and the column
number are placed in braces/curly brackets (see example 4).'°

'® The reason for this complicated structure is that the same folio number cannot be provided in the transcriptions of two
texts belonging to the same manuscript (for example, in the transcription of the last page of 1 John and in that of the
first page of 2 John). The braces/curly brackets {...} have the effect of ‘hiding’ the second occurrence of the folio
number when the transcriptions are processed, but still enable us to see them (in this example, the folio number at the
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Example 1 Example 2 Example 3 Example 4
|F 107v]| {I[F 107v[} |C 3|{|F 107v|} {IF 107v]|C 2|}
|C 1

Only the first folio number and (if applicable) column number needs to be placed in braces/curly
brackets if the new text begins part way down a page, not subsequent folio and column numbers.

If a text begins part way down a page because there is an illustration or decorated headpiece at the
beginning of the page, rather than the end of a previous text, do not treat the text as beginning part
way down the page. In other words, record the folio number and, if applicable, the column number
without braces/curly brackets.

beginning of Luke would be in braces). If one of the folio numbers is not in braces the result would be an error in the
processing of the transcriptions.
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5. Alteration of the Base Text in the Transcription

The following guidelines on altering the base text to create a transcription are intended for all
transcribers, those who are adding page layout information, and those who are not. Those who are
not adding page layout information will notice the following symbol in the diagrams: |L|. This
symbol indicates the beginning of a new line in a manuscript and can simply be ignored if you are
not adding page layout information.

The goal of the transcription is to reproduce the text of the manuscript as completely as possible.
Therefore all orthographic, itacistic, grammatical and lexical variations are recorded.

The base text remains unchanged in those places where the manuscript being transcribed agrees
with it. When the manuscript differs, the base text is changed to match it. So if, for example, the
text you are transcribing reads prnfavia and the base text reads PndaPapa in John 1.28, delete the
Pap of PnbaPapa and replace it with vi.

5.1 Inscriptions and Subscriptions

An inscription is the title of a book, recorded at the beginning of the copy of the text. A subscription
is a statement added at the end of a copy of the text, indicating what it is. It 1s sometimes followed
immediately by a statement of the next book. Both inscriptions and subscriptions are to be recorded
in the transcription. Abbreviations are written out in full, with added letters recorded in parentheses,
for example, 1w(avvnv).”

A line break tag should precede both inscriptions and subscriptions. For inscriptions the block
marker <K 0><V 0>, in other words, chapter 0, verse 0, is used. A subscription is indicated by a
chapter and verse number following the number of the last chapter in the document, and verse 0.
For example, a subscription in the Gospel of John, with the last chapter of John being chapter 21,
would be tagged as <K 22><V 0>.

Example: Tagging Inscriptions and Subscriptions

|F 283r] |L|... ypa@oueva BipAix aunv
|L|<04> <K 0> <V 0> gvaryyeAlov KATA 1WAVVNV IL|<K 22> <V 0> T0 KaTA 1WAVVNV Xy10V EVAYYEALOV
IL|<K 1> <V 1> ev apxn nv o Aoyog ...

5.2 Word Division

If you are recording page layout information in your transcription, you will be including the tag |L|
at the beginning of every new line. If you are not recording page layout information, it can be
helpful to add a carriage return after the last word of a line of text in the manuscript. This helps you
see where you are in your transcription. Whether or not you are including the |L| tag, if a word runs

'"See 5.7.5 Nomina Sacra, Ligatures and Abbreviations.
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over two lines, the word is split by adding an equals sign ‘=" at the point where the word breaks. Do
not introduce a space in your transcription at the point where the word breaks.

Example: Word Broken over Two Lines

With line break tags: |L|...eopa= Without line break tags: ...eopa=
IL|xauev ... KOUEV ...

It is important to remember that, during the process of transcribing, you will be using two keyboard
layouts, English and Greek Polytonic. You can add the equals sign ‘=" from both keyboards, but
while using the English keyboard the stroke is simply =, on the Greek Polytonic keyboard it is Alt +
=. If you are in Greek Polytonic mode, remember to key Alt + = to indicate a word division,
otherwise you will find that you have keyed something like ...copa”™ instead of ...eopa=. Conversely,
if you are in English mode, and you inadvertently key Alt + =, you will find that you have keyed
something like ...eopa# .

If the beginning of a word is lacunose'® or illegible'’ at the end of one line but the rest of it is extant
at the beginning of the next line, the ‘=’ is positioned after the relevant tag:

Example: Partially Lacunose Word Broken over Two Lines

IL...["Jeopal\]-

ILlxauev ...

If a line break divides a corrected word — a word in ‘app tags’® — the |L| and the = are recorded only
within the tag of the first hand reading ([*]...[\*]). The correction ([C]...[\C]) then follows the
reading of the first hand without including the |L| or the =:

Example: Corrected Word Broken over Two Lines

|L|...[app][*]eopa=
|IL|kauev[\*][Clewpakapev[\C][\app] ..

5.3 Omissions and Lacunae

5.3.1 Omissions

Omissions can be defined as places where the text is present in the base text but not in the text of
the manuscript you are transcribing. If the omission consists of less than one verse, the omitted
section is simply deleted from the transcription.*’

In the case of an omission of an entire verse, the text of the entire verse is deleted but the block
marker is retained and a reference to the omission is added in brackes/curly brackets in the
following way: {om}, for example, <V 17> {om}. If a block of verses is omitted, delete the omitted

'8 For lacunae see 5.3 Omissions and Lacunae and ‘Lacuna’ in Glossary.

' For instructions on dealing with illegible text, see 5.4.2 Illegible Text.

29 < App tags’ are explained at 5.5.1 App Tags and First Hand Reading Tags.

! The only time that an omission of less than one verse is indicated in a transcription is when the omission is part of a
correction and it becomes necessary to record it in order to clearly present the reading of the correction. See 5.5.3
Correction of Omissions or Deletion by Correctors.
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text but retain each verse block marker followed by a reference to its omission, without adding new
line breaks:

Example: A series of Continuous Omissions

|L|<K 2> <V 1> {fom} <V 2> {om} <V3> {om}

5.3.2 Lacunae

A lacuna, for the purposes of transcribing, can be defined as a section of text that is missing because
the material on which the text is written is missing. It is different from an omission in that an
omission is when text is present in the base text but not in the text of the manuscript you are
transcribing because the scribe left it out. It is also different from illegible text because the material
upon which illegible text is written is still extant and the text itself cannot be read (see 5.4 Difficult
to Read Text).

A lacuna can range from one letter — for example a rodent has nibbled a corner of a page — to
several pages — for example a whole quire is missing. Most minuscules contain no lacunae, so this
section really only needs to be paid careful attention to if there is evidence that some
parchment/paper is missing, for example, if a leaf has been cut out of the manuscript. There are
three ways of tagging lacunae and quite often a combination of two or more are used for one lacuna:

* Partial line lacuna [*] [\¢]
* Complete verse lacuna { }
* The &lac; entity

Partial Line Lacuna [2] [\¢]

If at least one letter of a line is extant, the text should, if possible, be reconstructed and recorded
within the following lacuna tags: [°]...[\*]. Reconstruct text only if the space looks the same size as
the base text. There should never be a space between the opening tag and the first letter within the
tags, or the last letter within the tags and the closing tag.

Example: A Reconstructed Line with One Extant Letter

IL|x[*]at To @wg ev T okotial\9]

If text is missing from both the beginning and the end of a line, reconstruct and record within lacuna
tags the material that is likely to be missing:

Example: A Reconstructed Line with Lacunose Letters at Both Ends
IL|[2]xat ebeacauedal\e] tnv §[]JoEav[\?]

If individual letters of a word are missing and cannot be inferred with certainty (i.e, the size of the
space is different from what you might expect according to the base text), the estimated number of
missing letters that could fit into the lacuna should be recorded as a number or range of numbers, in
the lacuna tags:

Example: Estimating the Number of Missing Letters

22



Example: Estimating the Number of Missing Letters
IL|<V 27> vov 1 Yox[e]7-8[\]

So, even if a page is ripped vertically or diagonally and only one or very few letters are visible on
each line, the text would be reconstructed or replaced by numbers within the lacuna tags.

Closing Partial Line Lacunae

If a partial line lacuna continues onto the next line, it must be closed at the end of the complete
lacuna, not at the end of each line:

Example: Lacunae of Several Lines

|LlaAnBeia eot1 <V 18> kabwo e afJnect=
[Llethag[\°] e1¢ TOV ...

The exception is when the lacuna spans two columns or two pages, in which case it must be closed
at the end of each column or page and reopened at the next one:

Examples: Lacunae Spanning Two Columns or Pages

ILIEv npwtwv [Javtov ot padn=[\?]

IC 2|

IL|[2]ron Ae[\]yovTeg pafpr aye
|L[n o1 yoveig avtov wva tu[*JeAog[\?]
|F 363v|
[LI[2]yevv[\2]n6n <V 3> anekp1On

Similarly, if the lacuna spans the end of one verse and the beginning of the next, the tag must be
closed at the end of the verse, that is, before the block marker of the next verse, and reopened at the
beginning of the next verse:

Example: Lacuna Spanning Two Verses

[L]... avtwv e10e[]AnAv=
IL|®ate[\e] <V 39> [2]ex de[\] TN ...

Complete Verse Lacunae

If a complete verse or more than one verse is missing from the text because of missing material, the
block marker and the text of the relevant verse/s is deleted. This is in contrast to omissions,
where the text is deleted and replaced by {om} and the block marker is retained. The extent of the
lacuna is recorded in braces/curly brackets, for example, {2.12-25} meaning that chapter 2 verse 12
to verse 25 is lacunose. If an entire chapter is lacunose, the chapter block marker, the verse block
markers and the complete text of the relevant chapter are deleted, and again, the extent of the lacuna
is recorded in braces/curly brackets, e.g. {3.1-36}. If the lacuna extends into a new chapter or spans
several chapters, the extent of the lacuna is recorded in braces/curly brackets as usual, but the
relevant chapter block marker must be retained and added at the beginning of the text immediately
following the lacuna, otherwise the programme used for processing the transcription will assume
that the text following the lacuna belongs to the same chapter that precedes the lacuna:
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Example: A Lacuna that Extends into a New Chapter

IL|<V 31> efactacav ovv maAtv ABoug

Lot 1ovdatot va Abacwotv avtov {10.32-12.7}
|F 267r|

[L|<K 12> <V 8> TOULG TTTWYOLG YApP TTAVTOTE EXETE

This type of lacuna is usually used if part of a page, or a whole page or more has been removed
from the manuscript. It would be rare for it to occur alone, it would normally be used with one or
both of the other types of lacuna tag because it is rare for complete verses to be lacunose without
parts of other verses also being removed, see next section.

The &lac; Entity
The &lac; entity is used for all other lacunae. Some examples of its use follow.

Example 1. This is the most common use of this entity in minuscule manuscripts. A leaf has been
cut out of a manuscript and text on the extant page before the removed leaf ends part of the way
through a verse and the text at the beginning of the extant page affer the removed leaf begins part of
the way through a verse. The verses that are completely lacunose are recorded in braces/curly
brackets as detailed above. The lacunose text from the two verses either side of the removed leaf are
deleted from the base text and replaced by the &lac; entity. If they aren’t replaced by the &lac;
entity the programme used to process the transcription will assume the text has simply been omitted
by the scribe, rather than is lacunose.

These different elements are laid out as follows:

Example: A Missing Leaf Lacuna with Two Partial Verses Either Side of the Lacuna

[F 213v|

L] ...

|L|<K 2> <V 1> ka1 TN nuepa T TPITN YAUOG
[F 213v+|

|L|&lac; {2.2-9}

[F 214r-|

[L|<V 10> &lac;

|F 214r|

[LItpwtov tov kadov otvov T1fnot ka1 otav

* The extant pages are transcribed as normal.

* Two tags for the missing leaf are created, in this example they are |F 213v+| and |F 214r-|.
The first one repeats the folio number that precedes it and adds ‘+’ to indicate that it is the
folio that comes affer the last extant folio. The second one repeats the folio number of the
folio that follows it and adds ‘-’ to indicate that it is the folio that comes before the next
extant folio.

* The lacunose end of 2.1 would have appeared on the page after F 213v if it was extant and
so is replaced by &lac; on F 213v+, after the line break tag |L|.

* The complete verse lacuna ({2.2-9}) is recorded after the &lac; entity.

* The lacunose beginning of 2.10 would have appeared on the page immediately before |F
214r| if it was extant and so the verse block marker <V 10> is put on F 214r-, after a line
break tag |L| and the lacunose text of 2.10 is replaced by &lac;
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Example 2. A leaf has been cut out of a manuscript and text on the extant page before the removed
leaf ends part of the way through a verse but the text at the beginning of the extant page affer the
removed leaf begins at the beginning of a new verse:

Example: A Missing Leaf Lacuna with a Partial Verse Before the Lacuna

|F 213v|

|L|<K 2> <V 1> ka1 TN nuepa T TPITN YAUOG
[L|eyeveto ev kava tng yoAthaiag kat nv n
[F 213v+|

|L|&lac; {2.2-9}

[F 214r|

|L|<V 10> ko1 Aeyet avtw Tag avBpwog
|LItpwtov tov kalov owvov Tibnot kat otav

The same principle outlined above applies here, only there is no need to create a new folio (F 214r-)
to precede the first extant folio after the lacunose text as verse 10 begins on F 214r and not on the
page that precedes it.

Example 3. A leaf has been cut out of a manuscript and text on the extant page before the removed
leaf ends at the end of a verse. The text at the beginning of the extant page affer the removed leaf
begins part of the way through a verse:

Example: A Missing Leaf Lacuna with a Partial Verse After the Lacuna

[F 213v|

IL|<K 2> <V 1> ka1 TN nuepa T Tp1TN
|L|yapog eyeveto ev kava tng yaAhatag
Lot nv n untnp Tov oov eket {2.2-3.1}
[F 214r-|

|L|<K 3><V 2> &lac;

[F 214r|

|L|vukTog kat eimev avtw pafpt ov=
IL|dauev ot amo Beov eAnAvbag

Again, the same principle applies here, only there is no need to create a new folio (F 213v+) after
the last extant folio as 2.1 ends on F 213v. The complete verse lacuna ({2.2-9}) is recorded directly
after the extant text on the extant folio.

Example 4. More than one leaf has been removed from a manuscript. In such instances, there is no
need to record all lacunose folios, but only the one after the last extant folio, suffixed by +, and/or
the one before the next extant folio, suffixed by -, and only where necessary:

Example: A Missing Quire with Two Partial Verses Either Side of the Lacuna

|F 213v|

|L|<K 2> <V 1> ka1 T nuepa T TPITN YOUOG
[L|eyeveto ev kava tng yahAatag kat nv n
[F 213v+|

|L|&lac; {2.2-5.10}
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Example: A Missing Quire with Two Partial Verses Either Side of the Lacuna

|F 214r-|

|L|<K 5><V 11> &lac;

|F 214r|

|L|roinocag ue vyin eke1vog pot EIMEV apov

Example 5. The bottom half of a page has been removed:

Examples: Bottom Half of a Page Lacuna

[L|<K 9> <V 1> ka1 mapaywv e1[2]dev avOpwmov[\?]
[L|tupAov ek yev[eletng[\*] <V 2> [¢]kat npwtnoav avtov([\?]
|L|&lac; {9.3-6} <V 7> &lac;

[F 363v|

[Llvtaye vigat e1¢ Tnv koAvufndpav tov

[L[Aeyovteg pafpr t[e]ig nuaptev ovtog n o1[\?]
[L[yov[]eic avtov va tueAog yevvnon[\2] {9.3-6}
|F 363v|

[L|<V 7> ka1 e1mtev avtw vrayn vigat €1¢ TV

In the first example the last few extant lines are partial, there are several complete verses missing
and the next extant page begins part of the way though a verse. The lacunose text of the partial lines
is reconstructed if possible (or replaced with an approximate number of lacunose letters). The rest
of verse 2 (after the partial line) is lacunose so is recorded as such on a new line, followed by the
complete verse lacuna on the same line. The text on the next page begins part of the way through
verse 7 and so the lacunose text of verse 7 (&lac;) and the verse 7 block marker (<V 7>), are
recorded at the end of the transcription of F 363r. While it is clear that verse 7 does not begin on the
same line that verse 2 ends on, there is no need to calculate the number of remaining lines on a page
with the intention of putting the verse 7 block marker on the correct line.

In the second example there are no partially lacunose verses, only complete lacunose verses
recorded in braces/curly brackets, which can be recorded at the end of the line. Do not record the

probable number of missing lines on the page.

Example 6. The top half of a page has been removed:

Examples: Top Half of a Page Lacuna

L[kt mapnyev ovtwg <K 9> <V 1> ka1 tapaywv £18ev avBpwmov
[F 363r|

|L|&lac; {9.2-6} <V 7> &lac;

[L[ortaryn vigat e1¢ Tnv ko[2JAvpupnOpav tov sidwau[\?]

IL|<K 9> <V 1> ka1 Tapaywv €18V avOpwTov TUQAOV EK YEVETNG
|F 363r|
IL|{9.2-6} <V 7> ka1 e1[*]mev avtw vrayn vigat 1¢ tTnv koAvufnOpav([\?]

In the first example the text of the previous page ends part of the way through a verse, there are
several complete verses missing and the first extant line is partial. The lacunose text of 9.1 would
have been on the missing section of F 363r so replace the lacunose text with &lac; at the top of F
363r, followed by the extent of the completely lacunose text in braces/curly brackets. This is
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directly followed by the verse block marker and &lac; of the first partially extant verse of F 363r.
Again, while it is clear that the end of verse 2 and the beginning of verse 7 do not belong on the
same line, there is no need to calculate the number of lines on the page prior to the beginning of the
text with the intention of putting the verse 2 block marker on the correct line.

Example 7. A page consists of two or more fragments and there are several lines that are
completely missing between the fragments. The lines above and below the completely lacunose
lines are partially lacunose.

Examples: Lacunae of Several Complete Lines

IL|[2]Aeyovot Tw tu[\2]pAw maAy
|L|&lac;

|L|&lac;

[L|<V 18> &lac;

IL|[=]ot 1ovd[ \]atot Tept avTov OTL

IL|[2]tov BapapPav[\e] nv &¢ o PapafPfag {19.1}
L|&lac;

L|&lac;

[L|<K 19><V 2> &lac;

[L|[e]mAe€avTeg ot[\Jepavov €€ akavOwv

If several entire lines are missing, the transcription should reconstruct the number of missing lines
(in this case 3) by counting the probable number of letters in the missing text and then dividing by
the average number of letters on a line. The missing lines should be recorded with the line break tag
|L| and the lacuna entity &lac;. If it is clear that a partially extant verse began on a completely
missing line, record the verse tag on that line.

5.4 Difficult to Read Text

Sometimes it is very difficult to decide what a scribe actually wrote. Parts of letters may be
lacunose, the script itself may be illegible, the image you are using may be very poor, or there may
be ink blots and other marks obscuring the text. There are two ways that you can flag such
difficulty, as uncertain or illegible.

5.4.1 Uncertain Letters

Uncertain letters, in other words, letters that are so damaged that several interpretations could be
possible, should have a dot placed beneath them. This can be created by inserting Unicode character
0323, Combining Dot Below, immediately after the letter. A full list of letters with dots beneath is
available for copy and paste in the Items for Copy and Paste document.

If a letter is partially extant, yet could only be part of one letter (e.g. half of an omega) do not place
a dot beneath it.

For uncertain letters in a nomen sacrum, see 5.8.5 Nomina Sacra, Ligatures and Abbreviations.

5.4.2 Illegible Text
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[ill]...[\ill]

If it is clear that there is text present, but it is now completely illegible (as distinct
from lacunose), tag the ‘text’ as illegible. As with lacuna, missing text should, if
possible, be reconstructed and supplied within the ‘illegible’ tags:

Example: Reconstructed Illegible Text

IL|x[ill]Jor To pwo ev T okotial\ill]

If it is not possible to reconstruct the text with any degree of certainty, for example, if the base text
contains 15 characters and the area of illegible text is not large enough to contain 15 characters, put
the approximate number of illegible characters in ‘illegible’ tags:

Example: Estimating the Number of Illegible Letters

|L|amekp16n [ill]4-6[\ill] eyw Pantilw

5.5 Corrections and Alternative Readings

Corrections and alternative readings must be recorded in the transcriptions within square bracketed

tags.

5.5.1 App Tags and First Hand Reading Tags

[app]..[\app]: All tags that are used to record corrections, alternative and commentary readings are

[1.0\*:

embedded within so-called ‘app tags’. They define the extent of any given correction
and act as necessary ‘containers’ of all the different variables within any given
correction.

The first item recorded after the opening app tag is the first hand reading, which is
surrounded by the following tags: [*]...[\*]. In the case of corrections, this tag is used
to record the original, first hand reading. In the case of commentary readings, it is
used to record the text that is being commented on. In the case of alternative
readings, it is used to record the text that an alternative reading is being presented
against.

5.5.2 Corrector Tags

[c]..[\C]:

A change to the original text made by a corrector is then added within ‘corrector
tags’. A correction is a change to the original text, made by a corrector or the scribe
himself, indicated by erasure; bracketing; crossing out; dots above letters; or an
indication that material is to be transposed (usually by marking the text with small
numbers, letters or other signs). The replacement text may be written on the line,
between lines, or in a margin. Sometimes letters or words of the continuous text are
not marked in any way (e.g. they are not crossed out to indicate that they have been
corrected) but an alternative has been written interlinearly, for example, maidov,
written interlinearly above texvov. Such alternatives should also be treated as
corrections.
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The most basic corrector tag is [C]...[\C]:

Example of Tagging of a Basic Correction

[app][*IxkAnpoug[\*][ClkAnpov[\C][\app]

It 1s occasionally possible to discern a little more information about a correction. Sometimes, it is
clear that a correction has been made by the first hand in the process of writing; a first hand
correction is tagged as [C*]..[\C*]. The most obvious example is when it is clear that the scribe
began writing one word, realised his error part way through so stopped, and wrote another word
instead.”” The script must clearly be of the same hand, written as part of the main body of text. It
cannot be interlinear or marginal. If you cannot decide with any degree of certainty that the
correction 1s made by the first hand, tag it as [C]...[\C]. Sometimes it is also possible to distinguish
between more than one corrector in any given transcription. In such instances, they can be identified
with the tags [C1]..[\C1], [C2]..[\C2] or [C3]..[\C3]. Note that it is far more likely to be able to
distinguish between different hands (and inks) from a manuscript itself or a digital image of one,
rather than from a microfilm or a digital scan of a microfilm.

There should be no spaces between the different parts of the tags and the words.
The smallest unit that can be placed within corrector tags is one word, whether that word is a single
letter, such as the article n or a much longer word. Do not tag parts of words. For example, if the

word avtov has been corrected to avtov, tag the whole word, not just the nu and upsilon.

In a correction, if the letters of the first hand are illegible, the ‘illegible’ tag should be placed within
the ‘first hand’ tags:

Examples of Tagging an Illegible First Hand

[app][*][illJeavtwv xwpav\ill][\*][Clxwpav avtwv[\C][\app]
[app][*][ill]15-18[\ill][\*][C]to Atvov o oxiotov[\C][\app]

Some Further Examples of Corrections

TOLNTAL ASY VOUOU nowntat [app][*JAoy[\*][C*]vouou[\C*][\app]

Correction by the first hand made in the process of writing.
W [app][*Inopevsopebal\*][Clnopevowuedal \C][\app]
mopevcOpeEOa The dot above the omicron means that the corrector wishes to delete it
and replace it with the omega written above it.
1 [app][*]pacherac\*][C]paciAerac[\CI[\app]
PacAerao In this case, the corrector is clearly correcting a spelling mistake.
0 [app][*InA6ev[\*][CInABov[\C][\app]
ot avBpwmot nABev The plural subject requires the 3™ person plural of the verb; the

corrector has spotted the mistake and rectified it by writing the omicron
above the epsilon.

22 See the first example in the ‘Some Further Examples of Corrections’ box on the next page.
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Some Further Examples of Corrections

el BAYE i —
I CYMNII, |L|8¢ avtov cuvaipty

ﬁ%ﬁmc%u&r ILIpoonvexdn [app][*Jeiq

LY TWPIKET (chypan Hovrou\ N Clavtov ew\CNapp] ogiretng

Y ORAW NTAMNHF ILI[app]l[*ImoA wv\*][Cluvprwv[\CI\app] taratw

The signs /7, [ and /I] indicate a correction of word order.

5.5.3 Correction of Omissions and Deletions by Correctors

If a) an omission of the first hand ([*]) has been corrected, or b) a deletion of a word, phrase or
verse has been made by a corrector, the omission/deletion is indicated by &om; within the
appropriate tags.

Example: Omission or Deletion

a) [app][*]&om;[\*][Clovtwo[\C][\app]
b) [appl[*Jovtwe[\*][C]&om;[\C][\app]

5.5.4 Closing Corrector Tags

If a correction spans two or more lines, the corrector tag must be closed at the end of the entire
correction and not at the end of each line of the correction. Note that ‘=> and |L|, marking word
breaks and line breaks, are only recorded within the first hand tags ([*]...[\*]) and not in the

subsequent corrector tags ([C]...[\C]).

Examples of the Tagging of a Correction Spanning More than One Line

a) |L|oto ovtwo nv [app][*Tuvno=
|L|otevBiono[\*][CluvnotevBeiono[\C][\app]

b) |L|xvoo [app][*]umo Tov
IL|uodiov tebnvon[\*][Cliva vro Tov podiov tedn[\Cl[\app] n

If the correction spans the end of one verse and the beginning of the next, the tag must be closed at
the end of the verse, that is, before the block marker, and reopened at the beginning of the next
verse:

Example of the Tagging of a Correction Spanning More than One Verse

IL| ... [app][*]100=
IL|daras[\¥][Clyadharac[\C][\app] <V 29> [app][*]xat evBuo[\*][ClevBuo mavtayxn kai[\CI[\app]

Similarly, if an omission spans the end of one verse and the beginning of the next, and text has been
added by a corrector, the tag must be closed at the end of the verse and reopened at the beginning of
the next:

Example of the Tagging of a Corrected Omission Spanning More than One Verse

|L[uabnreg [app][*]&om;[\*][Clavrov[\C][\app] <V 11> [app][*]&om;[\*][Clxa1 18oveg[\C][\app]
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5.5.5 Alternative Readings

[AL.[\A]

An alternative reading usually only occurs in minuscules (though there are a few in
some majuscules). It is a reading that is different from the text, but is shown to be an
alternative rather than a correction by the addition of one of the following notes:

* gvalloio (avtrypagoio)
* evalw (avtrypaew)

s ® ypagetal or yeyp(amran)

An alternative reading should be recorded with the tag [A]...[\A] after the first hand
reading tags, for example, [app][*]texvov[\*][A]raidov[\A][\app].

5.6 Repetition of Complete Verses

Very occasionally, a single verse, or more than one verse, is repeated. Sometimes this is
immediately after the first time it is written, sometimes later.

If a complete verse is repeated, repeat the verse block marker at the beginning of the repetition and
enclose in braces/curly brackets {...}:

Examples of Marking the Repetition of a Complete Verse

[L|twv avBpwnwy <V 5> kal To QWG £V TH GKOTIX PALVEL KAL 1] GKOTLX
|L|avto ov katedafev {<V 5>} katl T0 QWG €V TH OKOTLA PALVEL KAL 1] GKO=
|L|tia avto ov katedaPev <V 6> eyeveto avOpwog ATEGTAAUEVOG TTAPA ..

|L|<V 48> eyw 1yt 0 apTog TG {wng <V 49> 01 TATEPEG VPWV EQAYOV
[Llev tn epnuw To pavva kat amebavov {<V 48>} eyw €1yt 0 aptog
|L|tng {wng <V 50> 0UTOG £6TIV 0 APTOG O EK TOL OLPAVOU ...

If the repeated verse is repeated in a different chapter, for example, a verse from chapter 11 is
repeated in chapter 12, repeat both the chapter and verse marker at the beginning of the repetition
and enclose in braces/curly brackets {...}.

When the text returns to the correct chapter, repeat that chapter block marker and enclose it in
braces/curly brackets:

Example of Marking a Repeated Verse from a Different Chapter

IL|<K 12><V 1> 0 ouv 1ncovg mpo €€ nuepwv tov Taoxa NABEV €1¢
[LlxpwVv inooug {<K 11><V 5>} nyana 8¢ o noovg tnv papbav kat Ty
[L|adeA@nv avtng kat tov Aalapov {<K 12>}<V 2> £moincav ovv auTw ...

If you have to record a repetition of a complete verse/more than a single complete verse, make a
note of it in the Status Note, saying which verse is repeated and on what folio.

When a scribe repeats a word or phrase (but not a complete verse), for example a scribe repeats 1o
mooyo TV wvdalwv in John 11.55, simply alter the base text accordingly:

Example of Marking a Repeated Word or Phrase (but not a Complete Verse)
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Example of Marking a Repeated Word or Phrase (but not a Complete Verse)

[L|<V 55> nv 8¢ eyyug To Taoxa Twv 1008AIWV TO TAGKA TWV
[L[tovdaiwv kat avePnoav ToAAot £1¢ 1eposoAvua ek
|L|tng xwpag Tpo Tov TasXa VA AyVIGWO1V EXVTOUG

5.7 Personal Comments on the Text

If there is anything of particular interest, or text that you find particularly difficult to read, you may
add a personal note commenting on the fact, after the text in question. For example, if you have
placed dots beneath some letters or word/s because the text has been partially obscured by an ink
blot, you may want to note that fact. In order that the programme doesn’t treat such notes as
readings, place them in braces/curly brackets, for example, eionyayev {ink blot obscures uncertain
letters}.

Important: Braces/curly brackets cannot be placed between block markers, for example, between
<K 4> and <V 1> in your transcription. Tags cannot be placed within braces.

Comments that pertain to the complete text should be added to the Status Note, under ‘Other
remarks’ (see 3.3 Status Note).

5.8 Miscellaneous Items

5.8.1 Symbols that are not to be Transcribed
Do not record the following items and symbols™ in your transcription:

* Catch words

* Colophons

* Custoden

* Binding Marks

* Ekphonetic Notation
* FEusebian Apparatus

* Euthalian Apparatus
* Hypodiaireses

* Hypotheses

* Kephalaia

* Spatium
* Stichoi
e Titloi

Do not record the following items and symbols in your transcription, but record their presence in
the Status Note (see 3.3 Status Note):

* Diples™

2 All of these items are defined in the Glossary.
** See ‘Diple’ in Glossary.
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* Initials and other enlarged letters
* Liturgical signs (for example, the lectionary notes apyn and ts?xog)zs
* Obeloi*

5.8.2 Accents and Breathing Marks

Accents and breathing marks are generally not to be transcribed. The only times that accents or
breathing marks are to be recorded are when the accenting/breathing alters the meaning of the text.
In such instances, three alternative readings are presented in the base text. The first option is the
word without an accent or breathing mark. The second and third options are the two alternative
readings with accents/breathing marks, recorded in braces/curly brackets, for example, pevet {uével
uevel} or avtov {avtov avtov}. Decide which of the three alternatives is the correct one and delete
the alternatives and the braces.

5.8.3 Punctuation Marks

Punctuation marks are not to be transcribed in minuscule manuscripts.

5.8.4 Tota Adscript/Subscript

Iota adscript: to be included.
Iota subscript: not to be included.

The reason for this is to encourage transcribers to record everything they see in the continuous run
of text, which should avoid the occasional mistaken omission of an iota that is not, in fact, an iota
subscript.

5.8.5 Nomina Sacra, Abbreviations and Ligatures

. 27
Nomina Sacra

Nomina sacra are abbreviated sacred names. They are recorded by copying the text of the
manuscript as it appears and always placing the overline above the second letter, for example, 1i¢ for
moovg and mva for mvevpa. The overline is created by inserting Unicode character 0305,
Combining Overline, directly after the second letter. A list of the most common nomina sacra can
be found in the Appendix and they are also available for copying and pasting from the ltems for
Copy and Paste document. It is important to note that they can be declined and that their form can
change accordingly.

In an abbreviated nomen sacrum that begins with a preposition, the overline is still placed above the
second letter, so, for example, emrovvia not erovvia.

Note: In some manuscripts sacred names, and sometimes other names such as metpog, are written
out in full, with an overline above any of the letters, such as metpog or iwavvng. The rule to follow
is: if the name is written in full, add the overline in the position it appears. Sometimes a nomen

 See ‘Lectionary Notes’ in Glossary.
% See ‘Obelos’ in Glossary.
*" See ‘Nomina Sacra’ in Glossary.
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sacrum 1s written without an overline, e.g. vv or 6v. The rule to follow in such instances is: omit
the overline. So, in both instances, record what is present. Also, in both instances, add the Latin
note sic next to the word in braces/curly brackets, as {sic}.

If only the overline is preserved, and the letter beneath it is uncertain, the letter should be recorded
with a dot beneath it. First type the letter, then the dot below, then the overline, in other words,
letter, Unicode 0323, Unicode 0305. A list of letters with underdots and overlines is available for
copy and paste in the Items for Copy and Paste document.

Abbreviations and Ligatures
Abbreviations and ligatures should be written out in full.

Abbreviated words have some clearly identifiable letters or symbols, such as the superline for final
nu, for example, eott for eotiv. Abbreviations can also be indicated by raised, small, letters. If an
abbreviated word contains a symbol replacing a letter, or contains small letters, record the symbol
and/or small letters as ordinary letters. For example, the final nu overline is simply transcribed as v.

At times, usually at the end of a line, you will see a shortening stroke that replaces the last few
letters of a word. Such a stroke is not a symbol for particular letters, but the letters it represents are
quite clear from the context. In such instances, record the missing letters as normal.

Sometimes some letters have not been written, but their omission is fairly common shorthand. For
example, ovd is sometimes written as a shorthand way of representing ovdei¢ and mp° is written as
a shorthand way of representing mpoc. These and other known shorthand expressions can be found
in several sources that deal with Greek abbreviations and ligatures.”® Such words should be
recorded in full so, taking these examples, ovd should be recorded as ovdeig and mp® should be
recorded as mpoc.

If a word is missing some letters, and you are not sure if it is a known abbreviation, the missing
letters should be enclosed by parentheses (...).

Example: Abbreviations

eottl should be recorded as sotiv
np° should be recorded as mpog
wovv should be recorded as iwavv(ov)
Tov a¥ amooto™ should be recorded as tov ay(1o0v) amootoA(ov)

Ligatures are formed when two or more letters are merged into one single form,” such as the
ending —tar. Gardthausen provides some differentiation of ligatures:*°

8 These sources include pages from C. Faulmann, Das Buch der Schrift, V. Gardthausen, Griechische Palaeographie
and T.W Allen, Abbreviations in Greek Manuscripts. You can request pdfs of this material by contacting Bruce or
Rachel.

¥ See ‘Ligature’ in Glossary.

3% A pdf of the relevant pages of V. Gardthausen, Griechische Palaeographie is available by emailing Bruce or Rachel.
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(1) Primary ligatures: two letters are written over each other so that they form one symbol,

for example, L
(2) Secondary ligatures: two letters are not just externally joined, but one part of the first

letter is simultaneously also part of the second letter, for example, NE  HN
(3) Tertiary ligatures: three or more letters are joined together into one inseparable unity, for

example,

Words that contain ligatures are written out in full.

Example: Ligatures

k = kat

Note: If you are unsure about how to record an abbreviation or ligature, put the relevant letters in
parentheses. It is worth remembering, however, that most of the time parentheses are not needed.
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6. Supplements

A supplement is an addition to a manuscript of at least one entire leaf or (very rarely) part of a leaf,
replacing original material. An important indicator of a supplement is a change of handwriting often
accompanied by a change in the number of lines or columns. A supplement can occur anywhere,
even at the very beginning of a manuscript.

If a document, for example 200040, contains supplementary material, the supplementary text should
be transcribed in a separate file. A note in braces/curly brackets should be inserted in the main text
file at the point where the supplement begins, saying {supplement here}.

The supplementary text, transcribed in a separate file, is given the suffix 1. So, for example, a
transcription file of supplementary text in 04 200040 rk is given the file name 04 200041 rk. A
second supplement would be given the suffix 2 (e.g. 04 200042 rk) and so on, though more than
one supplement is rare.

If the handwriting changes in the middle of a regular page this information should be recorded in

braces/curly brackets as {change of hand}. The same note should be also added to the status note. It
is not a supplement.
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7. Commentary Manuscripts

Commentary manuscripts contain, in addition to biblical text, commentary on the text by one or
more Church Fathers. The biblical text and commentary are usually distinguishable from one
another in one or more of the following ways:

(1) The biblical text and commentary may be written in different colours of ink and
sometimes in different scripts (majuscule/semi-majuscule/minuscule).

(2) The biblical text may be marked by diples (> or >>) in the margins.

(3) The beginning of the biblical text may be indicated by keupevov), while the beginning of
the commentary may be indicated by epp(nvia).

Some commentary manuscripts contain a block of biblical text in the middle of the page surrounded
by commentary in the top, bottom and outer side margins of the page. Some have lines of
commentary, followed by lines of biblical text.

Commentary text
Commentary text Commentary text
Biblical text
Biblical text
Biblical text
Commentary text
Commentary text
Biblical text
1 2. 3

7.1 Tagging Commentary Manuscripts

7.1.1. Using the {comm} Tag

In commentary manuscripts, only the biblical text is transcribed. However, in some circumstances,
the presence of commentary text is indicated with the following tag: {comm}.

In the first example above of a commentary manuscript, there is no need to use commentary tags
because the biblical text is in a block, just like a regular continuous text biblical manuscript. It is not
difficult to distinguish between commentary and biblical text. It should therefore be transcribed like
a continuous text manuscript, with no {comm} tags:
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Commentary Manuscript Example 1

|F 203v|

|L|<V 40> ekpavyacav ovv TaAY TAVTEG AEYOVTEG Un TOUTOV
[L|oaAAa Tov PapafPav nv 8e o PapafPag Anotng <K 19> <V 1> tote
ILlovv eAafev o mAaTOG TOV 1V KAl EHAGTIYWOE <V 2> Kal

[L|ot otpatiwtarl mAe€avteg ote@avov €€ akavOwy ...

L] ...

The {comm} tag should be used in examples 2 and 3 on each line of commentary text. It should be
used once for each line of commentary and a line break tag should precede each {comm} tag:

Commentary Manuscript Examples 2 and 3

|F 178v]|

IL|{comm}

IL|{comm}

IL|<V 4> Leyet ovth 0 1 TL ELLOL KO GOL YVVOL OVTL® NKELT) MPCL LoV
IL|{comm}

IL|{comm}

IL|{comm}

|F 1791

IL|{comm}

|IL|{comm}

|L|<V 5> Agyel n untnp a0TOL TOIG SLOKOVOLG O TL 0LV AEYT VULV TTOUNOATE
|IL|{comm}

|IL|{comm}

IL|{comm}

IL|<V 6> noav de ekel vopat ABvar €€ Keyeval Kota Tov kabapiopov
|L|tov 1o0vdaimv xmpovucat ave LETPNTOS VO 1) TPELS

7.1.2. Commentary and Biblical Text on the Same Line

If there is commentary text and biblical text on the same line, the {comm} tag is used to indicated
commentary text, and the biblical text is transcribed:

Example of a {comm} Tag and Biblical Text on the Same Line

|F 214v|

|L[{comm}

|L[{fcomm} <V 13> ka1 eyyvug nv o Tacxa Twv 10vdatwyv Kat avePn €16
|LJieposoAvua o ic {commy}

7.1.3 Pages Containing No Biblical Text

If a page in a commentary manuscript contains no biblical text there is no need to repeat the
{comm} tag for every line of commentary. Simply record |L|{comm} once, after the folio number:

Example of a Commentary Page Containing No Biblical Text

|F 39r|
|L[{comm}
|F 39v|

38



7.2 Unmarked Biblical Text

Occasionally there is no easy way of distinguishing biblical text from commentary text. This is
usually in manuscripts where a scribe has added diples (> or >>) in the margins to indicate biblical
text and he has simply forgotten to mark a passage. Other reasons include poor photography of the
manuscript pages, or the margins are not visible for some reason. If you cannot immediately find
the next expected piece of text, you will need to search the commentary text to see whether there is
some unmarked biblical text embedded within it. When you find it, transcribe as normal.
Sometimes a passage might actually be missing, in which case, replace text with {om},
remembering to retain the verse block marker (refer back to 5.3.1 Omissions).

7.2 Using the &ews; Entity

Usually, biblical text in commentary manuscripts is recorded in full. However, sometimes a scribe
will omit sections of biblical text from within a block of it and in place of the omitted text, write
ewc. For example, in G/A 732, F188r, in a single block of the text of John 1.49-51, the scribe:

e writes verse 49, the beginning of which is indicated by xeu(pevov) — see letters circled in
white in the image

* omits verse 50 and the beginning of verse 51, but indicates their existence with an
abbreviated form of the word ewc — see letters circled in black in the image

* and then writes the middle of verse 51.

Where the scribe records emg, which means ‘...’°, record the following entity: &ews; for each verse
or part verse where text is omitted:

Example of Using the &ews; Tag

’

SR oL . S G N PR e oy
PO TRPEYS- % f)g;;‘n!wa'.;/miE%:n,»'i,./\%;y'u:w'-"'r" > AEDAN Y

convrep ™
¢ v

4
gt I i
aus alaovsli QP ++* O
/

A VPO R TR AR = AR
|F 188r|
|L[{comm}
IL[{comm} <V 49> anekp1On vabavanA kat eimev avtw paPpt ov €1 0 vIOg
|L|tov 60 ov 1 0 PaciAevg Tov 1A <V 50> &ews; <V 51> &ews; Kol TOUG AyYEAOUG ...
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8. Ending the Transcription

Be sure to save your transcription at regular intervals throughout your work and when you have
finished the transcription by clicking ‘Save’ in the ‘File’ menu.

To leave Word go to Word>Quit Word.
To leave jEdit go to File>Exit.
To leave BBEdit go to BBEdit>Quit BBEdit.

Also, it is important to regularly back up your transcriptions in a place other than on your local hard
drive.

IGNTP transcribers should send their completed transcription to Bruce Morrill at
bruce@math.ksu.edu or Rachel Kevern at r.kevern@bham.ac.uk
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9. Appendix

This appendix contains information that you may find useful in the process of transcribing a text.

9.1 General Keystroke Table for Gentium using the Greek Polytonic Keyboard

Lower case
§ (1 |2 |3 |4 |5 |6 |7 (8 |9 |o |7 |”
: ¢ | |p |t |v |6 [t o [t |~ |
a |6 1d | |y |n (& |x A |7 " I\
6 x|y o B v ju |, 0

Note: The Greek Polytonic keyboard uses as different transliteration scheme from the one that you
may be used to if you have been using fonts such as Symbol Greek, or Symbol. The characters to
watch out for have been highlighted in yellow.

Upper case (+ Shift)
+ | @ [# |$ % (A & |* [( ) [T |
: " E P T |Y |© |I O |IT |t '
A | |A |® T |[H |[E |K |A |
& Z X |¥Y [Q |[B [N M |< > i
Lower case + Alt
s [+ [z 2 Je s 1 [x [+ [ T° - |-
O |F |€ e |™ ¥ |9 [t ¢ |w |l ]
v lc |+ |d O [ |j x |7 | ‘ I
; L 1p |1 | 6 |’ M |« » |/
Upper case (+ Shift) + Alt
+ A D ¢ _ +
F e T [y |6 c |= |t |}
C ® - . 13
b |2 | L - =
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9.2 The Most Common Forms of Nomina Sacra

avog avBpwmog ouVOg ovVpPavog

dad dautd e Tatnp

0¢ Beog va TVELHA

1Anu 1EpovGaANU TIVIKOG TVELUATIKOG
'8 1160UG 0TPOG OTOLPOG

mA 1opanA ofp owTNP

10 LWAVVNG oplx OwWTINPLO

KG KLPLOG ug V100G

pnp untnp XS Xp1oTo6

It is important to note that the nomina sacra can be declined and change their form accordingly, so
Beov becomes BV and Bgov becomes OV etc.

The overline is Unicode 0305: Combining Overline. It is inserted after the letter that it goes above.

A list of the most common forms of nomina sacra are available for copy and paste from the ltems
for Copy and Paste document.

9.3 List of New Testament Book Numbers

Book NA UBS | Number Book NA UBS | Number
Matthew Mt Mt 01 1 Timothy IT ITm 15
Mark Mc Mk 02 2 Timothy 2T 2Tm 16
Luke L Lk 03 Titus Tt Tt 17
John J Jn 04 Philemon Phm Phm 18
Acts Act Ac 05 Hebrews H He 19
Romans R Ro 06 James Jc Jas 20
1 Corinthians 1K 1Cor 07 1 Peter 1P 1Pe 21
2 Corinthians 2K 2Cor 08 2 Peter 2P 2Pe 22
Galatians G Ga 09 1 John 1J 1Jn 23
Ephesians E Eph 10 2 John 2] 2Jn 24
Philippians Ph Php 11 3 John 3] 3Jn 25
Colossians Kol Col 12 Jude Jd Jd 26
1 Thessalonians 1Th 1Th 13 Revelation Ap Re 27

2 Thessalonians 2Th 2 Th 14
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9.4 Greek Numbers

a=1 1=10 p=100 _o=1000
p=2 K= 20 0= 200 _B=2000
y=3 A=30 =300 _Y =3000
0=14 =40 V=400 (y) etc.
€=5 v=50 @=500

=6 (o+alt) =60 (j) X =600 C = stigma
Z= 7 0=70 P =700 (0 0= koppa
n=38 1= 80 w =800 (V) 2= sampi

0=9 (u) 0= 90 (q+alt) 2 =900 (c+alt)

Examples of Numbers

&n =68
coe =275

9.5 Itacism (similar sound) and Isochronie (same sound)

Itacism (similar sound):
The following groups have a similar sound:

1 €l o1l N V)
¢ & at

e B v (Sav1d - dafrd)
Isochronie (same sound):

The following group has the same sound:

W (0]

9.6 Contacts

Bruce Morrill at bruce@math.ksu.edu
Rachel Kevern at r.kevern@bham.ac.uk
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10. Glossary

The terms marked by an asterisk are from D.C. Parker, An Introduction to the New Testament
Manuscripts and their Texts (Cambridge University Press, 2008).

*Apparatus

Asterisk

A critical apparatus (often given its Latin name apparatus criticus) refers to the
section usually at the bottom of the page (or after a block of text — in either case
below the text) which contains the variant readings and statements of manuscripts
supporting each one. The word apparatus is good English, with a plural apparatuses,
but it is also good Latin. A Latin noun of this class has a plural form which is spelt
the same, but with a long instead of a short u, so one will find the plural apparatus or
apparatus critici. Like other Latin nouns of this class, it tended to become confused
with another class also ending in -us, but with a plural in -i. So one may occasionally
find the plural form apparati critici. Whether one chooses English or Latin, the
correct plural form is unambiguous so long as the adjective is supplied.

A text-critical symbol found in some ancient manuscripts, the meaning of which is
not completely understood. It is only transcribed in selected passages.

Catch Words Along with custoden (see below), catch words are used to indicate the order of

*Catena

*Citation

*Clavis

*Codex

*Collation

Colophon

gatherings. The first word of the following gathering is repeated at the end of the
previous gathering, usually in the bottom margin. This information is not
transcribed.

A collection of quotations from early Christian writers linked together to form a
commentary on a biblical writing.

A quotation of a passage from the New Testament in an early Christian writer.

In the present context, a manual listing all the works of the Church Fathers to have
been written in a particular language, including brief details and information on the
available editions.

A document made by folding sheets of material in half and combining them in one of
a number of possible ways to make what is recognised as a book today.

A list of differences between a manuscript and a base text. Sometimes a number of
separate collations are combined into one. Such a collation is the base of an
apparatus.

A closing formula in which the scribe provides information regarding, for example,
his or her name, the name of the patron, and/or the circumstances surrounding the
production of the manuscript (that is, location, date, etc.). This information is not
transcribed.

Commentary Manuscripts
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Manuscripts that contain, in addition to the biblical text, commentary on the text by a
Church Father (or several Church Fathers, see Catena). The biblical text and
commentary are distinguishable from one another in the following ways:

(1) The biblical text and commentary are written in different colours of ink and
sometimes in different scripts (majuscule/semi-majuscule/minuscule).

(2) The biblical text is marked by diples (see below) in the margins.

(3) The beginning of the biblical text is indicated by kei(uevov), while the beginning
of the commentary is indicated by epu(nvia).

Commentary Diacritical Marks

Symbols, letters or numbers that clarify the relationship between a biblical text
passage and its commentary.

*Continuous-text manuscript

Custoden

This term distinguishes manuscripts which are not lectionaries, that is they contain
the text or texts in full and in an accepted order.

Numbers (normally Greek) or symbols that indicate the beginning and/or end of a
quire. Usually, though not always, found in the lower, outer margin. They are not
transcribed.

Binding Marks

Diple

Dittography

*PDuctus

Marks made in the outer margins of the middle leaf of a gathering (quire) to indicate
the middle of the gathering for the purpose of binding. They are not recorded in a
transcription.

(= &mAf]) Marks like > or >> made in the margin, next to certain text, to indicate
that it is a quotation from the Old Testament. Occasionally, the biblical book will be
named. In a commentary manuscript diples can serve as markers of biblical text,
distinguishing it from commentary text. Diples are not transcribed, but if they are
present in a manuscript, their presence, and location (folio number), should be noted
in the Status Note.

A copying mistake in which a word, a syllable, or a letter that occurs only once in
the exemplar is written twice in the copy. (Compare Haplography.)

Example: Jn 5.3

... ET0.0GE TO VOWP ... ... ETOLGGETO TO VOWP ...

The way in which a particular scribe has written, referring not so much to the shape
of the letters as to the way the pen is handled and the letters are put together.

Ekphonetic Notation

Ekthesis

Refers to symbols added to provide guidelines for the liturgical use of a text. These
symbols, which look like extra accents, are written in a different ink colour to
distinguish them from the text. They are not transcribed.

The first full line of a new section, projecting into the left margin, sometimes
accompanied by an enlarged letter.
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Eusebian Apparatus
‘A system providing a means for users to navigate their way between parallel
passages in the Gospels.””!
It has four elements:
(1) Every Gospel is divided into numbered paragraphs, the number being written in
the margin against the beginning of each section.
(2) A list of ten tables at the beginning of the Gospels that list parallels between the
Gospels.
(3) The number of the table containing each paragraph is written underneath every
section number in the margin of the text.
(4) A short explanation of how they work, written by Eusebius to one Carpianus (see
pp-84*-85* of Nestle-Aland).

The individual paragraphs of the Eusebian divisions are known as Ammonian
sections.

The Eusebian apparatus is not transcribed.

Euthalian Apparatus
Supposed to have been compiled by one Euthalius. It consists of various
supplements and textual divisions in Acts, the Pauline and Catholic Epistles. The
Euthalian apparatus of the Catholic Epistles, for example, contains the following
elements:
(1) mpoAoyog: Prologue
(2) avakepalaiwolg Twv avayvwoewv: Lists of readings (avayvwoelg), chapters
(kepadaia), Old and New Testament quotations (paptuptat) and stichoi (otiyot),
organized by the individual Epistles and for the Catholics all together.
(3) mpoypappa: Preliminary remarks on the marking of the quotations.
(4) avakepalaiwoig Oetwv paptuptwv twv KaboAikwv: List of the quotations for
each individual Epistle. It provides the quoted books of the Old and New
Testaments in order, as well as the number of the quotations from these books and
the order in which they appear.

Example
€V TN ENIOTOAN 1KwPov In the Epistle of James there are four quotations
HOPTUPLAL TEGOAPEG (Testimonia).
YEVECEWG O, Y From Genesis: one, namely the third [quote of the

Epistle of James].

egodov a, B From Exodus: one, namely the second.
Agvitikov a, o From Leviticus: one, namely the first.
TAPOLULWV a, & From Proverbs: one, namely the fourth.

(5) [Before each Epistle] vroBeoio: Table of contents.
(6) [Before each Epistle] (ekbeo1g) kepalaiwv: List of the chapter headings.

3110.3.1 of Parker’s Introduction.
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(7) [At the end of the Catholic Epistles] Stichometric data as well as the epilogue:
avtePAnOn de twv mpalewv kat kaboAikwv emtotoAwv to PipAtov mpoo ta akpiPn

aVTLYpa@a TnG ev Katoapela PipAtodnkng evoefrov tov mapgiiov.

The Euthalian apparatus is not transcribed.

*Family of manuscripts

At least two, but generally more manuscripts which may be shown to be related to
each other and derived from a common archetype, it being possible to illustrate this
relationship by means of a stemma.

*Folio The name for one side of a leaf. The two sides are called the recto and the verso.
These terms are used in two ways:

(1) In a parchment or paper manuscript, the right-hand page is called the recto, and
so 1s often indicated with the numeral followed by . The left-hand page is the verso,
and thus called v. The possible ways of numbering leaf 50 of a manuscript are

recto 50r 50a 50

verso 50v 50b  50v or 50b

Abbreviated as fol., F, f. Plural folios abbreviated as foll., Ff, ff.

(2) In a papyrus manuscript, the recto is the side in which the horizontal fibres are
uppermost, the verso the side in which the vertical fibres are uppermost. These are
often indicated as

recto 50—

verso 507

Note that older works may use the terminology now applied to parchment and paper
manuscripts also to papyri.

*Gathering A set of sheets bound together at the centre as one of the units making up a codex (in
the case of a single-quire codex, the only unit). The most common number of sheets
is four, called a quaternion. The word quire is synonymous with gathering.

Gloss Short explanation of a particular text added to the manuscript, usually in the margin
(see also Scholia). These are recorded, marked as commentary readings
([app]*INFIKINKI\app)).

Example: G/A 1739, fol. 8r, Acts 7.43
poAoy in the text is explained in the margin with eildwAov pwapitwv
*Gregory’s Rule

The general custom in production of parchment manuscripts of folding the sheets so
that an opening contains two hair sides (which are darker) or two flesh sides. It was
described by C.R. Gregory, Canon and Text of the New Testament, Edinburgh, 1907,
323-5. (To be precise, Gregory’s Rule applies to the observation that Greek
manuscripts contained quires of four sheets and ensured that the outermost side was
flesh; but it is also used in this more general way.)

*Group of manuscripts

At least two, but generally more manuscripts, which show clear signs of being
closely related, but whose stemma cannot be reconstructed.

47



Haplography A type of copying mistake in which words, syllables, or letters that appear twice in

the exemplar are copied only once (compare Dittography).

Example: 1 Thess 2:7

... €yevnonpuey_ynmiot ... eyevmoOnpuey nmiot

Homoeoarcton

Means ‘identical beginnings’ and relates to the identical beginnings of words close to
one another in a piece of text, such as avtov and avtwv. This can mislead a copyist,
looking back and forth between exemplar and copy, who can skip over verses or
parts of verses, accidentally omitting what lies between two words with identical
beginnings.

Example: Homoeoarcton Acts 22.22

NKOVOV 3€ [@VTOV aP)L TOLTOL TOL AOYOV
KO ETN POV TNV QOVNV] QUTOV AEYOVTEG ...

Homoeoteleuton

Hypodiairesis

Hypothesis

*Incipit

Inscription

Means ‘identical endings’, and like homoeoarcton is a frequent cause of copyist error
as the copyist’s eyes skip from the end of one word or sentence to another word with
an identical ending, accidentally omitting what lies between them.

Example: Homoeoteleuton Acts 22.22

NKovoV 8€ 0VTOL [aPYL TOVTOL TOV] AOYOL

KO ETN POV TNV QOVIV QUTOV AEYOVTES ...

‘Subtitles’ belong to the kephalaia (see Kephalaion). The vmodiapeoeio are
recorded in the kephalaia (chapters) lists and sometimes receive separate numbers as
subsections. At other times there is no difference made between them and the
kephalaia and they are numbered with them. They are not transcribed.

A summary of a document that is usually written directly before the document itself.
In the case of catenae, the hypotheses are found at the beginning of the
commentary.>” They are not transcribed.

(1) The standardised phrase introducing a lection intended to indicate the context (for
example, ‘Jesus said’).

(2) The opening half-dozen or so words of a writing used in identifying it.

The title of a book, recorded at the beginning of the book.

32 A compilation of the hypotheses can be found in H. von Soden, Die Schriften des Neuen Testaments in ihrer dltesten
erreichbarren Textgestalt hergestellt auf grund ihrer Textgeschichte, 4 vols (Gottingen, 1902-13) 1.300ff.
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Isochronie

*[tacism

*K

Kephalaion

*Lacuna

*Lectionary

Examples of Inscriptions

*  apXn TOL KATX UAPKOV EVAYYEALOV
*  mpatelg TWV AnooToAWV
*  TOV aYloV 1wavVoL Tou BeoAoyou emoToAN KaBoAikn TpwTn

Inscriptions are transcribed with any abbreviation written out in parentheses (...).
They are given the block markers ‘chapter 0, verse 0’ (<K 0><V 0>).

When an omicron and omega are pronounced the same.

Strictly speaking, a spelling variation involving the letter iota, it is also used more
generally for any kind of spelling variation where vowels or diphthongs are
exchanged.

In addition to Parker’s Introduction: In New Testament and Byzantine Greek vowels
and diphthongs were pronounced similarly which is how spelling variation involving
vowels and diphthongs became so common.

A siglum used by von Soden for the Byzantine text (K = Kowvr)). Generally used with
an added identifier, such as K" for the most controlled form, or K* for all manuscripts
not classified.

From at least the fourth century the NT texts were divided into sections called
kephalaia (= chapters). These were given numbers, and later names. In the
Apostolos, the kephalaia form part of the Euthalian apparatus (see above). The term
‘kephalaia’ can be used to describe either the text passage or the chapter heading,
also called ‘titlos’.

Examples of Kephalaia

Chapter number, or kephalaion Y

Chapter heading, titlos, or kephalaion TEPL TNG TTPOG EKACTOV AYATING
ATOGTWTOANUTTOV KATA TOV VOUOV

A loss of text, usually caused by the material on which a manuscript was written
having been lost. Sometimes it is due to the disappearance of ink. Plural ‘lacunae’.

A manuscript containing the text of church lections rather than the full text of a
writing, the readings being in their lectional sequence.

Lectionary Notations

Additions to the text that indicate the liturgical use of a text passage, with the
beginning and end of the reading normally marked by apyn and teAog.

Example of a Lectionary Notation

teA(06) g £'tng N'efd(aopadog)
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*Lemma

Ligature

*Majuscule

Menologion

*Minuscule

Frequently, the beginning of the lectionary reading will be repeated. This can result
in a variation in the running text of a manuscript as the lectionary notation is
incorporated into the text, for example, a passage might be introduced with adeApot
Hov or gv talo nuepats ekewvaic. Being of liturgical use only, these are not to be
transcribed.

The abbreviations ¥ (= vmaye) and L (= (nte1) are lectionary notations; they
stipulate that the following text passage should be skipped during the reading.

The abbreviation G (= capPatov) is also a lectionary notation, and should be

distinguished from a similar abbreviation > (= onuewwteov), which is written in the
margin to indicate something noteworthy (similar to the modern exclamation mark).

The passage of Scripture about to be discussed quoted at the beginning of a section
in a commentary.

Ligatures are formed when two or more letters are merged into a single character.
Gardthausen provides some differentiation of ligatures:
(1) Primary ligatures: two letters are written over each other so that they form one

symbol, for example, S
(2) Secondary ligatures: two letters are not just externally joined, but one part of the

first letter is simultaneously also part of the second letter, for example, NE  HN
(3) Tertiary ligatures: three or more letters are joined together into one inseparable

unity, for example,
Words with ligatures are transcribed in full.

A Greek script written with each character written separately, the letter shapes
generally conforming to the upper case equivalent in modern printed and written
Greek. Sometimes in the past called uncial.

A collection of readings for saints’ days and other special occasions. The readings
begin on 1% September. The menologion is organised according to the names of the
months (unv = month). In contrast to the menologion the synaxarion (see below)
contains readings for all the church services of the church year.

A compact Greek script developed in the ninth century, which combined certain
letters in sequence and increasingly used ligatures and symbols representing
commonly occurring sequences such as nominal and verbal endings. Also used of
Latin manuscripts showing the same general characteristics.

*Negative apparatus

A critical apparatus in which only differences from the base text are cited, silence
being taken to be agreement with the base.

Nomina Sacra

‘Sacred words’ written in abbreviated form with an overline above one or more
letters. They are recorded in a transcription with an overline above the second letter.
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Obelos An obelos is a diacritical mark. It generally serves to indicate text that is present in
the manuscript but which the scribe (or a corrector) thought should be deleted, for
example, the Pericope Adulterae (John 7.53-8.11). Obeloi are not transcribed, but if
they are present in a manuscript, their presence, and location (folio number), should
be noted in the Status Note.

Omission An absence of a text passage of any length, ranging from one letter to several
chapters, which is due to scribal omission, not physical loss of part of the
manuscript. Homoeoteleuton, for example, is one particular cause of omission.

*Opening The two pages of a codex when it is opened flat, with verso on the left and recto on
the right.

*Opisthograph
A roll which has been written on the outside. Usually only the inside carried writing.
Such use of the outside usually constitutes the re-use of the roll once the text on the
better side is no longer required.

Pagination Unlike foliation (see Folio above), with pagination (Latin = paginae) the sides, not
the leaves, are continuously numbered. The page number can be found in the upper
or lower margin (usually the upper outside corner of a page) and may be written in
either Greek or Arabic numerals. They should always be transcribed using Arabic
numerals.

*Palimpsest A manuscript which has been rewritten. The first writing (the underwriting) has been
scraped off (Greek mdAwv (= ‘again’) and Pdw (= ‘scrape’) and a second (the
overwriting) replaces it. Some manuscripts are overwritten twice; sometimes a new
manuscript is made from the scraped leaves of more than one older manuscript.

*Papyrus A writing material made from a reed of this name, and hence a manuscript written on
this material.

*Paratextual Textual material in a manuscript which is not a part of the text(s) which the
manuscript transmits, such as running titles, page, quire or paragraph numbers.

*Patristic citation
See Citation.

*Positive apparatus
An apparatus is which differences from the base text and agreements with it are both
given.

*Quaternion See Gathering.

*Quire See Gathering.

*Received Text

Most accurately applied to any printing of the text of the Greek New Testament as it
was published by the Elzevir Brothers in 1633. It is also used generically of all such
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texts, including its precursors, namely the editions of Erasmus, Stephanus and Beza.
Often referred to in its Latin form as the Textus Receptus.

*Recto See Folio.

*Scholia (1) Comments or notes in the margin of a manuscript.
(2) Excerpts from commentaries, placed in the margin of a copy of the text.

In addition to Parker’s Introduction: The difference between scholia and glosses (see
above) is not exact. In general, glosses are limited to an explanation of facts in as
short a form as possible, whereas scholia offer something more like a commentary.
Like glosses, scholia should be transcribed and marked as commentary readings

([app]*IN*IIKIN\K]\app)).

Section See Eusebian Apparatus
*Siglum (Latin) The number, letter or abbreviation used to indicate a witness in an apparatus.
Plural sigla.

*Singular reading
A reading found in only one manuscript.
g y p

Spatium The Latin term for spaces the width of at least two letters that have been left by the
scribe. Even if the free space has later been filled in, for example by apyn or telog,
it is still regarded as a spatium. These spaces are not recorded in a transcription.

*Stemma A ‘family tree’ of manuscripts, showing how a family of known manuscripts is
related, and what missing links (lost manuscripts) there are between them.

Stichos According to Gardthausen®” the classical authors called otixot ‘raumzeilen’ or ‘space
lines’ (in contrast to ‘sense lines’ = kwAa). Stichometric information, the number of
stichoi or lines on a column or page assisted with the measuring of the length of a
document, and thus also with the wages of the scribe. A count of the stichoi served
as a check on the completeness of a document. This information is not transcribed.

*Subscription
A statement added at the end of a copy of a text, indicating what it is. Sometimes
followed immediately by a statement of the next book.

In addition to Parker’s Introduction: The subscription is to be recorded in the
transcription. The subscription is given block markers consisting of a chapter
number after the last chapter number of the work and the verse number 0 (for
example, a subscription for Mark would be recorded as <K 17> <V 0>).

Examples of Subscription

*  TeAOG TOL KATA PUAPKOV EVAYYEALOV
*  mpaelg TWV AMOGTOAWY

V. Gardthausen, Griechische Palaeographie: Das Buchwesen im Altertum und im byzantinischen Mittelalter, 2" edn,
2 vols, (Leipzig, 1911-13) 2.72.
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Examples of Subscription

*  TPOG TITOV TNG KPNTWV EKKAEGLAG TTPWTOV EMLGKOTOV EYPAPH ATIO
VIKOTIOAEWG TNG HAKESOVING

*Sub-singular reading

Supplement

*Surrogate

Synaxarion

Titlos

*Tradent

A reading found in only two manuscripts.

An addition to a manuscript of at least one entire leaf or (very rarely) part of a leaf,
replacing original material. An important indicator of a supplement is a change of
handwriting often accompanied by a change in the number of lines or columns. A
supplement can occur anywhere, even at the very beginning of a manuscript.

If the handwriting changes in the middle of a regular page this information should be
recorded in braces/curly brackets as a change of hands. It is not a supplement.

A reproduction of a manuscript in photographic form (printed, microform, or digital
image). A version available on the Internet may be from any of these three sources.

A collection of readings for the regular church services of the liturgical calendar. In
contrast to the menologion (see above) the synaxarion starts at Easter. It contains
readings for each day of the year.

A chapter heading (title) in which the contents of the relevant kephalaion or
hypodiairesis (see above) are briefly summarised. In the kephalaia lists preceding the
individual New Testament documents the titloi are listed with their associated
kephalaia numbers. In addition, the titloi are often also repeated in the appropriate
place in the text, usually in the upper or lower margin. They are not transcribed.

‘A person or community that passes on the tradition of the Scriptural text’ (dela
Cruz’s definition®). Used here to describe the role of a manuscript as a carrier of the
text.

*Transcription

*Uncial

*Verso

A word-for-word and letter-by-letter copy of a manuscript, usually preserving its
page layout. It may be in either paper or electronic format.

A term denoting a type of Latin script, broadly analogous to Greek majuscule.

See Folio.

3% See 4.1 of Parker’s Introduction.
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